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Project 1 - Business Proposal (PowerPoint) 
 

… extraordinary faculty, inquisitive and talented students, a constant striving to build upon and expand 
historical strengths, the vision to anticipate the future, the intellectual capital to develop new knowledge, 
and the resources to provide the financial support and physical setting to make all these things possible 
… 

Steven B Sample, Former President, University of Southern California 
 

Congratulations.  It is May 15th, 2016 and you have just graduated from the University of Southern 
California.  Armed with nothing more than your class ring and your education, you aim to eclipse your 
peers by establishing your own business.   

An arduous journey lies before you … and the first step is to create a business proposal.  With your 
business proposal, you can solicit funding from venture capitalists eager to work with a fellow Trojan. 

After examining several sample business plans, you determine that you need: 
• Business focus 

o a mission statement describing the purpose of your business 
• List of your specific products 

o what products your business will offer your customers 
o choose tangible products rather than services 

• Market analysis 
o target demographics – who will be interested in your product 
o market place – what other players are in your area of business 

• Expected cash flow 
o how much revenue will you generate 
o how much money will you spend 
o when will your business become profitable 

• List of partners 
o who’s going to work with you 
o what are their qualifications 

 
As you continue through the semester, the remaining projects will follow your business proposal from 
its inception to its first year on the Fortune 100 list. 

You need to keep all your projects as they build on each other and may utilize 
components already created. 
Save your work to your flash drive.  Please ask the lab assistant for help if you are 
unsure of how to save to an external device. 
Project Objectives 

• Create a Business Proposal using PowerPoint to create the following slides: 
1. Title page 
2. Your Company’s Mission Statement 
3. List of two products with pictures and descriptions of each 
4. Bulleted market analysis listing customers and competitors 
5. Chart displaying expected cash flow 

• Submit your project on Blackboard 
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Instructions 
1. From the Start Menu, open Microsoft PowerPoint 2010. 

2. From the main menu, click the File tab.  In the column down the left side, the Info option should be 
selected.  If it is not, then click the Info option.  In the column along the right side, click on the 
Properties pull-down and select the Advanced Properties option. 

3. In the Properties window, click on the Summary tab.  Enter the following: 

Title: Your company’s name 

Subject: Your company’s name’s 

Business Proposal 

Author: Your name 

Manager: Your instructor’s name 

Company: USC 

 

4. In the Properties window, click the OK button. 

5. Before you do anything else, save your document.  You should still have the File tab selected.  
Click the Save option, which is right next to the Save icon.  

6. In the Save As window, click on the Documents option in the left panel or click on your Removable 
Drive (flash drive). 

7. Click on the Create New Folder button in the top right hand corner.  

8. In the New Folder window for the Name textfield, enter itp101.  Click the OK button. 

9. In the Save As window for the File name textfield, enter lastname_firstname_powerpoint where 
lastname and firstname are replaced with your actual last and first names.  You do not need to 
include the .pptx file extension.  It will be added to the end of your filename.  Click the Save button. 

Slide 1 – Title Slide 

10. From the main menu, click on the Design tab.  

11. Select one of the design themes by clicking on one of the 
images. 

12. Change the colors by clicking on the Colors pull-down to 
the right of the theme images and selecting one of the color 
palettes. 

13. Within the title box (where it says Click to add title), type 
your company’s name and Business Proposal. 

14. Within the subtitle box, type your name and your email 
address. 

15. Feel free to adjust the font sizes and rearrange the text boxes to enhance the slide. 

16. Save your work by clicking on the Save icon in the upper left corner of the window.   
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Slide 2 – Mission Statement 

17. Creating another slide by clicking on the Home tab and clicking on the New Slide icon. 

   This creates a Title and Content slide. 

18. In the Title box, enter Mission Statement. 
19. In the Text box (where it says Click to add text), enter your 

mission statement.  If you need help creating a mission 
statement, use your web browser to read 
http://en.wikipedia.org/wiki/Mission_statement.  You may 
also read other companies’ mission statements. 

 

 

Slide 3 – Products 

20. In the Home tab, click on the New Slide pull-down right under the New Slide icon. 

21. Select the Two Content slide option. 

22. For the Title, enter Products. 

23. In the two text boxes, type brief descriptions for your two 
products.  Feel free to adjust the font size to fit your text. 

24. Remove the bullets.  To do so, make sure the Home tab is 
selected.  Under the Paragraph section, select the bullet 
icon pull-down and select the None option. 

25. Adjust the hanging indent tab.  To do so, move the index 
tab on the ruler.  If the ruler is not displayed, then select the 
View tab and click in the Ruler checkbox. 

26. You need two images showing your products.  If you do not have your own images, then browse 
the web for images using a web browser such as Firefox or Internet Explorer.  Go to Google 
(http://www.google.com) and enter search criteria.  Click on the Images option in the top menu bar 
or the left-side navigation bar.  When you locate a picture on the web, right-click on the picture and 
select the Save Image As… option.  Save the image to your itp101 folder within the My Documents 
folder on your computer.  Do not pick images that have a watermark or copyright. 

27. Insert your image onto your slide by clicking on the Insert tab and clicking on the Picture option. 

28. In the Insert Picture window, browse to the location of your image files.  You can multi-select them 
by holding the control key and clicking the two images.  Click the Insert button. 

29. Resize your pictures so they are nicely displayed on the slide by dragging their sizing handles with 
your mouse.  You may use the arrow keys to move the pictures.  Hold the control key down while 
using the arrow keys for very small movement. 

30. To add effects to your pictures, select one of your pictures and click on the Format tab. 

31. To align your pictures with each other, hold down the shift key and click on each of your images.  In 
the Format tab, select the Align option. 

32. Save your presentation. 
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Slide 4 – Market Analysis 

33. In the Home tab, click on the New Slide pull-down and select the Title and Content option. 

34. For the title, enter Market Analysis. 

35. Within the text box, enter the words Low, Moderate and High with a dash after each and a different 
color for each. 

 

There are several forces that act upon a company and affect its 
potential for success in the market place.  Using the Porter’s 
Competitive Forces model, these forces are: 

• Potential Entrants – the ability for new companies 
to enter the market place and raise competition 

• Buyers – the ability for the consumer to dictate the 
price you can offer your product at 

• Substitutes – the number of different products 
which the consumer might be willing to purchase in 
place of your product 

• Suppliers – the ability of suppliers to control how quickly you can offer your product to the 
consumer and at what price 

• The Industry – how volatile the market place is depends on the number of players, 
technology, and perhaps how consumer tastes change 

These forces can be evaluated as Low, Moderate, or High. 

For example, evaluating the Trojan Treats sample company, you might rate the following forces as 
follows: 

• Potential Entrants – Low (because of large starting capital needed) 
• Buyers – Moderate (because buyers can choose competitor’s bakery goods) 
• Substitutes – Moderate (other dessert items can be considered substitute goods) 
• Suppliers – Low (because there are a lot of suppliers who you could use) 
• The Industry – High (many companies fighting for market share and trying to establish 

“name” recognition) 

For your company, select a rate (Low, Moderate or High) for each of the forces. 

36. Draw a diagram showing the forces and their weight by using the three colors you chose.  To draw 
shapes, click on the Insert tab and the Shapes pull-down.  Select the shapes you want to use such 
as an oval and rectangles. 

37. To enter text in each shape, just click on the shape (you will see a dotted rectangle around it) and 
start typing text.  Use the Home tab to adjust the text font and size. 

38. To add the arrows, click on the Insert tab and the Shapes pull-down.  Under the Lines section, 
select the arrow image.  For each arrow, attach the head of the arrow to the shape holding your 
company name.  The small circle will turn red when it is attached.  Attach the tail of the arrow to one 
of the force shapes.  Again, the small circle will turn red when it is properly attached. 

39. To add effects to the shapes such as shadows, click on the shape.  Click the Format tab, and then 
click the Shape Effects pull-down.  This tab also contains pull-downs to align shapes and rotate 
them. 
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40. Select all the objects used to make the forces diagram (shapes and arrows) so we can group them.  
To multi-select, use the shift key.  Under the Format tab, click the Group option.  Alternatively, you 
can hold the control key, click each object, right click on the mouse and select the Group option. 

41. Save your presentation. 

Slide 5 – Expected Revenue and Expenses Chart 

42. In the Home tab, click on the New Slide pull-down and select the Title and Content option. 

43. For the title, enter Expected Revenue and Expenses. 

44. Click on the Insert Chart icon in the middle of the slide.  It has 3 colored 
bars. 

45. In the Insert Chart window, select the first Line chart option. 

 

46. Click the OK button. 

47. Microsoft Excel will open since MS Office is interactive with other office programs.  A chart in 
PowerPoint will be saved as an Excel spreadsheet. 

48. Change the values in the datasheet of the graph.  To change a value of a cell, select the cell and 
type in your values.  To input numbers into a box, just click on the box and start typing.  All changes 
will automatically be reflected in the PowerPoint chart. 

a) Change the cell Series 1 to Revenue. 
b) Change the cell Series 2 to Expenses. 
c) Click on the D column.  Right-click and select Delete. 
d) Change Category 1, Category 2, Category 3, and Category 4 to the current year and the next 

three years. 
e) Make up some Revenue and Expense values and 

enter them in the datasheet. 

49. Close Excel by clicking on the x button in the upper right 
corner.  If you want to edit the data, simply right click on the 
chart and select the Edit Data… option. 

50. Click on your chart and then click the Design tab. 

51. Click on the Select Data option. 
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52. In the Select Data Source window, make sure the Revenues and Expenses are on the left-hand 
column and the years are listed in the right-hand column.  If you need to switch them, then click the 
Switch Row/Column button.  Click the OK button. 

53. In the chart in PowerPoint, select the Revenue data line.  Right click and select the Format Data 
Series… option. 

54. Change the color of the line by selecting the Line Color option in the left column.  Select the Solid 
line radio box.  Change the Color to a green color. 

55. Change the weight of the line by selecting the Line Style option.  Increase the Width. 

56. Modify the Expenses data line by changing the line color to red and increasing the weight. 

57. Remove the grid lines from the chart by clicking on the chart and selecting the Layout tab.  Select 
the Gridlines option  the Primary Horizontal Gridlines option  the None option. 

58. Save your presentation.  

Final Touches to your Presentation 

59. Add a footer to your presentation which displays the date and slide number on each slide other than 
the Title slide.  Click on the Insert tab and select the Header & Footer option. 

60. In the Header and Footer window, click the checkbox next to the Date and time option.  Click the 
checkbox next to the Slide number option.  Click the checkbox next to the Don’t show on title 
slide option.  Click the Apply to All button. 

61. View your presentation using the Slide Sorter by selecting the View tab and the Slide Sorter 
option.  You also have access to this at the bottom right of the PowerPoint window.  Use the slider 
to increase or decrease the size of the slides. 

62. Add transitions from one slide to the next.  You can set the same transition for all of the slides or a 
different transition for each of them.  In the Slide Sorter view, select all slides by clicking on the first 
slide, holding down the shift key and clicking on the last slide.  Another way to select all slides is to 
hold down the control key and click the A key. 

63. Click on the Transitions tab and select one of the effects.  Verify that the whooshing star   
appears below each slide indicating that the transition has been applied. 

64. View your slide transitions by clicking on the selecting the Slide Show tab and the From 
Beginning option.  (You could also click the Slide Show icon  at the bottom right of the 
window.)  To advance through your slides click your mouse or use the arrow keys. 

65. Return to the Normal view of your presentation by selecting the View tab and Normal option or 
clicking on the Normal view icon  at the bottom right of the window. 

66. Select your Expected Revenue and Expenses slide (#5). 
67. Add animation to your chart by selecting the Animations tab.  Click on the chart. 

68. Click on Add Animation  Wipe under the Entrance section. 

69. To change the direction, click on Effect Options  From Left. 
70. Change the Start pull-down to the With Previous option. 
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71. Click on Effect Options  By Series.  It is breaking up the parts of the chart into a series of 
events.  Click on the Animation Pane option.  You will see the Animation Pane on the right side 
and the three steps for the animation.  We want the grid and legend to not animation.  To the right 
of the first step, click on the down arrow and select the Remove option. 

72. In the Animation Pane, you should see two steps – one for the Revenue line and one for the 
Expenses line.  For each step, the Start pull-down should be set to the With Previous option.  If it 
is not, fix it. 

73. In the Animation Pane, click on the second step.  Change the Delay pull-down to 00.50 (or greater). 

74. View your animation by clicking on the Preview icon on the far left of the Animations ribbon.  The 
Revenue line should wipe in from the left.  After it is done, the Expenses line should wipe in from 
the left.  If you use Slide Show to test it, then you should not need to click the mouse or arrow keys 
during this animation sequence. 

75. Go to your Market Analysis slide.  Animate your bullet list (Low, Moderate, High) so that each bullet 
line displays one at a time and automatically (without the need to click the mouse or arrow keys 
during the presentation).  Use the Animations ribbon and the Add Animation option (your choice).  
Use the Effect Options pull-down to change its properties and to make sure the animation is a 
sequence by paragraph.  Each step in the Animation Pane should have the Start pull-down set to 
the With Previous option.  Use the Delay pull-down to add delay values to the Moderate and High 
bullets.  The High bullet should have a larger delay value so it will be shown after the Moderate 
bullet. 

76. Save your presentation.  The file should be named lastname_firstname_powerpoint where lastname 
and firstname are replaced with your actual last and first names.  Windows will automatically 
append the .pptx file extension.  The file should be in a folder named itp101 on your flash drive or in 
the Documents folder. 

 
 Submitting your Business Proposal 

77. Submit your PowerPoint file on Blackboard (http://blackboard.usc.edu) by the due date. 

a. Click on the Assignments option in the left navigation bar. 

b. Click on the Lab1 item. 

c. Next to the Attach File label, click on the Browse My Computer button. 

d. Find your PowerPoint file (lastname_firstname_powerpoint.pptx) and click the Open button. 

e. Click the Submit button.  (If you click the Save as Draft button, the graders will NOT have 
access to your file.) 

 
 

Congratulations on completing your first ITP 101 project! 
 

 


